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Excel Lists

Excel’s primary claim to fame is performing mathematical calculations but it can do more. You can
use Excel as a database (also called a data list or a data table) program to organize, sort, filter and
analyze a collection of related information. For example, an address book is a database list of names
and addresses. A database uses field names or labels at the top of each column to identify
different kinds of information in the list. Each row in the database contains all the information about
an item in the list (also called a record).

Design a List
e Type the names of the fields in the first row of the worksheet. This is the header row.
Each field name must be unique. It doesn’t matter what order you put the field names.

e Enter the first record below the field names. Remember, do not skip any rows. You cannot

have any empty rows between the header row and the records that follow.

1is a Row header

A is a Column header

State is a Field name j

A B [¢ D [/ £ F G H I J K
1 | Firstname | Lastname | Street City ‘State Zip Phone | Email Birthday | Startdate | Years
2 | Andy Black 345 Topeka | KS 66602 | 234- ablack@xyz.com | Feb 1 3/6/2002 7
Oak 5678
3

Row 1 is called the header row which contains all the field names. Records start in row 2.

After starting the list, you may decide to add or delete some fields. To insert a column, click
on the column header to the right of where you want to put a new column. Remember that
column headers are the letters of the alphabet. Right click on the selected column header
then click on Insert. To delete a column, right click on the column header then click on

Delete.

Click on cell I2. It is a date with no year. If you type Feb 1, Excel will automatically add the
current year to the date. To type a partial date, type a single quote * before the date to make
it a text field and not a date field.

Click on cell K2. Notice that there is a number in the cell but look at the formula bar to see
the true content. K2 has a formula in the cell: =YEAR(TODAY())-YEAR(J2)
(There are no spaces or zeros in this formula. Use left and right parentheses). This is a
nested formula that is easiest to see in parts. If you type the function =TODAY() you would
get today’s date. Basically, the formula in K2 says to take the year of today and subtract
from it the year of the start date which is the date in cell J2. Don't worry if this formula
doesn’t make sense to you, yet. We just want to show you some of the fantastic things you
can do with Excel.

Enter or Add Data
To add to a data list, click in the first empty cell below the header row. In the example
above, that would be cell A3. To move to the cell to the right, press the Tab key or the right

arrow key

Topeka & Shawnee County Public Library ® 1515 SW 10" Avenue ® Topeka KS 66604-1374
785.580.4606 @ class@tscpl.org ® www.tscpl.org ® 10/28/10


mailto:ablack@xyz.com

Excel Lists 2

Auto Complete will complete your typing if you've typed the same word in that column
previously. For example, in cell D3 in the City column, if you type a £ Excel will finish typing
Topeka because it appears in the cell above (D2). However, if you want Tecumseh instead,
keep typing. The next time you type a city that starts with T, Excel will not know which city
you want until you type the second letter. If you type to, it will complete Topeka. If the
second letter is an e, it will complete Tecumseh.

Delete Data

To delete typing in a single cell, click on the cell and press the Delete key on the keyboard.
To delete an entire row, click on the row header of the row you want to delete. Right click
on the row header, then click on Delete. Remember, do not leave empty rows in a list.

To delete an entire column, click on the column header of the column you want to delete.
Right click on the column header, then click on Delete.

Find Data

There are 3 major ways to find data in a list.
e Auto Filter—use to find a group of similar data. Find it on the Home & Data tabs.
e Sort—sort the data alphabetically or numerically. Home & Data tabs.
e Find—use to find specific words in a list. Home tab.
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From the Data ribbon, click on Filter. Notice little down arrows by each field name in row 1.

A B C D E F G H | J K L Mo
1 |Firstnal » |Lastnal » [Street ~|City  ~|Stat ~|Zip ~|Phone ~|Email ~|Birthda ~ |Startdat: v [Yea v | —
2 [Andy_ IBlack  3450ak Topeka | KS  66602-1234123-5678  ablackd Feb | 362002 1
3 (Chris Jones 456 Maple Bernton  KE BE409-1234123-6738 clonesig Mar 14 9115949 4

I : A B C . ID ]

N TTiTer— Click on the down arrow by City in cell D1.

3 Chri z . . ay =

s ekl e , Un-check the Select all box. Click in the check box by one of the cities

B Jin in the list. Click OK. See a list of the records that have that city.

8 Pa ' . . . . . e .

H 2; e ' Notice the little filter icon by City which indicates that a filter has been
al (Select All) . .

11 Tl erven applied to that field.

13 Tod [ Topeka

14 [ Wakarusa

16 To get all the cities back, click on the filter icon. Check Select all. OK.

17

18

19 . . - -

2 To remove the down arrows. click on Filter in the ribbon.

22
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From the Data ribbon, click on Sort. The Sort dialog box appears.

FEE
’7‘&2 "-’;1 Add Level ” >( Delete Level ” 53 Copy Level ] i > Options. .. My data has headers |~

A Column Sort On Order K

1 Firstnamel (Sortby [Lastname | [values v| [awz v || fars
2 |Andy 8
3 |Chris 1
4 |Clem 17|
5 |Jean 22
6 |Kim 10
7 |Lou 32
8 [Pat Birthday 15
9 |Ray Startdate 8
10 [Sam |fears | [ oK ] [ Cancel 7
11 [Taylor 27
12 |Terry Anderson 321Pine Topeka KS 66611 000-6789 tanderson¢Mov 11 2/1/1996 14
13 [Tod Smith 567 Cedar Topeka  KS 66604 123-7890 tsmith@sx, Apr 1 10/7/1998 12

Click on the down arrow in the Sort by box. Click on Lastname.

Click on the Add Level box to see a secondary sort. Click on the down arrow in the Then by
box and click on Firsthname. Then click OK. You can have up to 64 levels of sort. Just click on
the Add Level box to add another level. To delete a level, click on Delete Level.

Now, the list will be sorted by last name and within that by first name. In our example, Andy
Black will appear before Jean Black.

The Order may be listed as: To sort numbers so that the largest number
A to Z or Smallest to Largest is at the top of the list, choose Z to A or
Z to A or Largest to Smallest Largest to Smallest.

From the Home ribbon, click on Find.

Find and Replace

Find | Replace

Find whak: |Lee w |

| Fndal || Endnext | [ close |

In the Find what: box, type the word that you want to find in the spreadsheet. Click on
Find Next to see the results.
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Every Excel Workbook has 3 worksheets named Sheetl, Sheet2 and Sheet3. See the
worksheet tabs in the bottom left of the active worksheet. You can rename the worksheets
and color code them.

\ A2 - f | Andy [=
A B c D E E G H | J K L M N o =

1 Firstname Lastname Street  City State Zip Phone  Email Birthday Startdate Years el
2 And 1Black 345 0ak Topeka KS 66602 123-5678 ablack@x:Feb 1 3/6/2002 8

3 [Chris Jones 456 Maple Berryton  KS 66409 123-6789 cjones@:x Mar 15 9/15/1999 11

4 |Clem Carson 101 Hazel Wakarusa KS 66546 123-2345  cclub@xy: Sep 26 5111993 17

5 |Jean Black 345 Oak Topeka KS 66602 000-5678  jblack@xy Aug 30 4/4/1988 22

6 |Kim Lee 207 Plum Lawrence KS 66044 123-3456 klee@xyz. Oct 17 3/1/2000 10

7 |Lou Wilson 789 SpruciTopeka  KS 66606 123-9012  lwilson@y Jun 6 4/1/1978 32

8 |Pat Taylor 678 Pear Topeka KS BBG05 000-8901 ptaylor@x: May 17 11/1/1995 15

9 |Ray Gonzales 407 PeachBerryton KS 66409 000-7890 rgonzalesi Dec 30 7/1/2002 8

10 |Sam Spade 690 WalnuTopeka KS 66607 000-0123 sspade@xJul 4 21172003 7

11 Taylor Brown 123 Elm  Wakarusa KS 66546 123-4567 thrown@sx Oct 4 6/7/1983 27

12 Terry Anderson 321 Pine Topeka KS 66611 000-6789 tandersongMNov 11 2/1/1996 14

13 | Tod Smith 567 Cedar Topeka KS 66604 123-7890 tsmith@xy Apr 1 10/7/1998 12

14

15

16 Insert...

i Delet:

13 Delete

19 Bename

20 Move or Copy...

21

&

22 & Miew Code

23 &l Protect Sheet...

24 Tab Color »

= l
27

28 Select All Sheets -
W 4+ M| Mal SRestzShERr [ m ] (3l
Ready | P [EEEET e 1] (+)

Right click on a worksheet tab. Click on Rename to give the sheet a different name. Press
the Enter key when finished typing. Right click again on the tab and choose Tab Color to
add color. Another way to rename a worksheet is to double-click on the worksheet tab. Type
the new name and press Enter.

Link data to another worksheet or workbook

Use the same data in more than one worksheet without retyping. If you make changes or
additions to the original or source worksheet, those changes will appear automatically in the
linked worksheets.

To link data from the same workbook, first click in the cell where you want the data to
appear. Type an equal sign =. Type the source worksheet name followed by an exclamation
point 1. The ! tells Excel that you typed a worksheet name. Then type the cell reference
where the data already exists. Example: =MaillA2

To link data from a different workbook, first click in the cell where you want the data to
appear. Type an equal sign =.Type the source workbook or file name surrounded by square
brackets. Type the source worksheet name followed by an exclamation point 1. The ! tells
Excel that you typed a worksheet name. Then type the cell reference where the data already
exists. Example: =[ExcelLists.xIsx]Mail!A2

Another way to link data (this is much easier):

In the source file, select the data you want to link.

From the Home tab, click Copy.

Open the destination worksheet or file and click where you want to insert the data.

From the Home tab, click on the down arrow under Paste. Click Paste Link.
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Hide & Unhide columns or rows

Select the columns or rows you want to hide by clicking on the column header or the row
header. Right click to see a menu. Click on Hide. To unhide columns or rows, select the
columns to the left and right or the rows above and below. Right click to see a menu. Click
on Unhide. If you want to unhide many columns or rows at the same time, select the entire
worksheet. A quick way to select the entire worksheet is to click on the shaded box to the
left of the A in the column headers.

Freezing the Panes
Click to the right of the column or below the row you want to freeze. Click on the View tab
and click on Freeze Panes. Click on Freeze Panes in the menu that appears.

(0 = XHEQ - Bookl - Microsoft Excel - =2 x
—' Home Insert Page Layout Farmulas Data Review View Developer @ - 7 X
age Break Preview ormula Bar £ | E Cig Mew Window  [—] Spli
3 L Page Break Previ V| Formula B = B = New Window [ Split - ==
IjJ Custof S | A” V¥ Headings A —= ﬂ Arrange All — Hide E‘I =a
Mormal| Page Zoom 100% Zoomto Save Switch Macros
Layout = Full's e eCt Selection |J:_rl Freeze Panes.~ Workspace Windows -
Workbook Vieys Show/Hide Zoom Freeze Panes | Macros
Keep rows and columns visible while the rest of Ev
) ﬁ" the waorksheet scrolls (based on current selection). =
- = T - T =
A B c D E F a H Freeze Top Row 0 [
1 Keep the top row visible while scrolling through
2 the rest of the warksheet.
3 Freeze First Column
4 Keep the first column visible while scralling
through the rest of the worksheet,

You can freeze columns or rows to keep the labels in view as you scroll through larger
worksheets. The area you freeze will not scroll. To Unfreeze, click on the View tab and click
Freeze Panes. Click Unfreeze Panes.

COUNT Functions

Examples
COUNT Number of cells with numbers in a range =COUNT(R6:R25)
COUNTA Number of non-blank cells in a range =COUNTA(R6:R25)
COUNTBLANK Number of blank cells in a range =COUNTBLANK(A2:A50)

COUNTIF Number of cells in a range that meet a certain criteria  =COUNTIF(B2:B13,"Black”)

SUM Function
Use SUM to add a range of cells that have numbers. Example: =SUM(R6:R25)

Absolute Cell Reference

By default, Excel treats the cells you include in formulas as relative locations rather than set
locations. When you copy formulas, the cell references adjust with the rows or columns. To
make a cell reference stick so that it will not adjust, use the $ to indicate an absolute cell
reference. Example $A%$2 If that cell reference is copied to another cell, it will not change.
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